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ГЛАВА 1 
 

ВВЕДЕНИЕ В ТЕХНИКУ ВЫШИВКИ 

КРЕСТОМ 
------------------------------------------- 
 

Вышивка крестом является популярной 
техникой заполнения больших зон малым 
количеством стежков. Такие стежки можно 
использовать также для оконтуривания и 
обрамления. Вышивание в такой технике 
подходит для украшения домашнего 
текстиля, скатертей, детской одежды и 
фольклорных мотивов. Стежок для вышивки 
крестом иногда комбинируют с 
аппликацией. 
В отличие от машинной вышивки, в которой 
проекты усовершенствуются различными 
типами и углами наклона стежков, а также 
разными эффектами, при вышивке крестом 
вы можете только добавлять формы к 
проекту с различными оттенками цвета. По этой причине в 
большинстве проектов вышивки крестом используется 
больше цветов, чем при машинной вышивке. 
В этом разделе дается обзор различных стежков для 
вышивки крестом. 

 

Типы стежков для вышивки крестом 
 
Стежки для вышивки крестом создаются на основе квадратных матриц, или "пикселей". Может быть 
вышита любая часть квадрата, от краев до диагоналей. Ниже проиллюстрирован полный диапазон 
стежков для вышивки крестом: 
 

 

Full Cross  
Полный крест 
 

 

Upright Cross 
Прямой крест 

Three-Quarter Cross  
Три четверти креста 
 

Double Cross 
Двойной крест 

Half Cross  
Половина креста 

Elongated Vertical Cross 
Удлиненный по вертикали крест 

 

 

Quarter Cross 
Четверть креста 
 

 

Elongated Horizontal Cross 
Удлиненный по горизонтали крест 

Mini Cross  
Мини крест 
 

Single Line 
Одиночная линия 

French knot 
Французский узел 
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Заполнение стежками для вышивки 
крестом 
При использовании стежков для вышивки 
крестом для заполнения вы можете выбрать 
любой тип этих стежков. 
 
Стежок "Полный крест" 
Стежки этого типа – это два пересекающихся 
стежка одинаковой длины, образующие крест 
(Х).  Общий эффект заполнения зависит от того, 
на каком стежке находится Х – ниже или выше. 
Вы можете также смешивать расположение 
стежков для специальных эффектов. 

 
 
 
 
 
 
 
 
 

узор стежка "Полный крест" 
 
Стежок "Три четверти креста" 
Стежок этого типа обычно создается из четверти 
креста, за которым следует половина креста. 
Другой эффект получается при выполнении 
вначале половины креста, закрепляемой 
четвертью креста. 
 

    
Узор стежка "Три четверти креста" 
 
Примечание: Длинное плечо стежка "Три 
четверти креста" может иметь направление "/" 
или "\". Нередко четверть стежка и стежок три 
четверти креста разных цветов образуют 
простой квадрат. При смешивании и подгонке их 
положения можно получать различные эффекты. 

   
смешивание стежков в четверть и три четверти креста 
 

 
Стежок "Половина креста" 
Половина креста – это простой диагональный 
стежок, имеющий вид "/" или "\". Стежки этого 
типа обычно используются для создания тени 
или фоновой тени. Стежок может начинаться от 
любого угла. Иногда две половины стежка 
разного цвета используются для создания 
полного креста. Стежок "Половина креста" может 
быть выполнен в разном направлении в 
зависимости от нужного вам эффекта. 
Например, этот стежок, используемый для 
изображения перьев, может иметь тот же 
наклон, что и сами перья.  
 
 

 

узор стежка "Половина креста" 
 
Стежок "Четверть креста" 
Стежок этого типа используется для создания 
более сложных узоров. 
 

 
узор стежка "Четверть креста" 

 
Стежок "Мини крест" 
Стежки "Мини крест" образуются двумя стежками 
равной длины, пересекающимися в виде "Х", но 
заполняющими только четверть квадрата.  
Используйте стежок "Мини крест" для таких 
деталей, как глаза, или для более плотных 
деталей проекта. 
 

 
 
 
 
 
 
 
 
 

 
узор стежка "Мини крест" 

 
 
Стежок "Прямой крест" 
Стежки "Прямой крест" создаются 
вертикальными и горизонтальными стежками. 
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Эти стежки можно располагать по диагонали по 
отношению к канве или по горизонтальным или 
вертикальным линиям. 

 
 
 
 
 
 
 
 
 
 
 

узор стежка "Прямой крест" 
 

 
Стежок "Двойной крест" 
Этот стежок образуется двумя стежками полного 
креста, повернутыми на 90є. Двойной крест 
напоминает звезду. Он обычно используется с 
произвольным расположением или в виде рядов 
для образования декоративного обрамления. 

 
узор стежка "Двойной крест" 

 
Обычно верхняя нитка нижнего креста является 
располагаемым под углом 135є к горизонтали 
стежком, а верхняя нитка перекрывающего 
стежка является горизонтальным стежком. 
 
Стежок удлиненного креста 
Стежок удлиненного креста состоит из двух 
стежков равной длины, пересекающихся в виде 
"Х". 
Имеются два типа: 
◄ стежок "Удлиненный по горизонтали крест" 
◄ стежок "Удлиненный по вертикали крест" 
Стежки удлиненного по горизонтали креста 
являются уменьшенными в два раза по высоте, а 
стежки удлиненного по вертикали креста - 
уменьшенными в два раза по ширине 
нормальными стежками полного креста. 
 

узор стежка "Удлиненный крест" 
 

 

Французский узел 

Французские узлы являются оригинальными 
рукодельными стежками, используемыми для 
придания "объемности" декоративной вышивке.  
Традиционно они используются в "белом шитье" 
с эксклюзивными хлопчатобумажными и тонкими 
шелковыми нитками. Французские узлы могут 
быть использованы в комбинации с другими 
стежками для вышивки крестом или 
оконтуривающими стежками. 
 

Узор стежков "Французский узел" 

 
 
Используйте этот стежок для изображения глаз, 
круглых дверных ручек, бутонов цветов или в 
виде бусинок в составляемых вручную проектах, 
а также для точки над буквой "I". Используйте 
его также для оконтуривания обрамления. 
Попытайтесь использовать полноцветные 
металлизированные или разноцветные нитки. 
Французские узлы лучше выглядят в крупной 
сетке. 
 
Обрамление стежками для вышивки 
крестом 
Стежок для вышивки крестом может быть 
использован для выполнения контура или 
обрамления. Можно также комбинировать 
стежки для вышивки крестом с другими типами 
стежков для получения специальных эффектов. 
Вы можете создавать контуры стежками типа 
Single Line (Одиночная линия) или Full Cross 
(Полный крест) или обоими этими стежками для 
более плотных контуров. Контур стежком Single 
Line обрабатывается программой как 
обрамление, в то время как стежком Full Cross – 
как заполнение.  Это важно знать, если вам 
нужно удалять обрамление, поскольку 
обрамление одиночной линией может быть 
удалено как одиночный объект, обрамление 
полным крестом – нельзя. 
 
Обрамление стежком "Одиночная 
линия" 
Стежки Single Line используются только для 
создания обрамлений или добавления деталей. 
Одиночная линия может быть помещена на 
любой стороне квадрата. Щелкните по стороне, 
на которой вы хотите поместить линию. Вы 
можете поместить одиночную линию 
обрамления на одной или на всех четырех 
сторонах квадрата.  
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Стежки обрамления одиночной линией могут 
быть размещены в квадратах, в которых уже 
имеется крест.  

 
Обрамление стежком "Одиночная линия" 
 
Обрамление стежком "Полный 
крест" 
Стежки "Полный крест" могут использоваться 
также в качестве декоративных оконтуривающих 
стежков. Если вы используете стежок "Полный 
крест" в качестве обрамления он будет тем же, 
что и был выбран для заполнения в списке Fill 
stitch type (Тип заполняющего стежка). Вы 
можете изменить его путем изменения типа 
заполняющего стежка. 

 
Обрамление стежком "Полный крест" 
 

Вариации стежка для вышивки 
крестом 
 
Ориентацию стежков с неполным крестом можно 
изменять для создания различных узоров с 
эффектами. Вы можете делать это 
непосредственно в каждом квадрате или путем 
настройки оконтуривающих стежков. Вы можете 
также комбинировать стежки с неполным 
крестом различными способами. См. также Типы 
стежков для вышивки крестом. 
 
Стежки "Три четверти креста" 
Стежки "Четверть креста" и "Три четверти 
креста" могут быть использованы для создания 
закругленных углов. См. также Заполнение 
стежками для вышивки крестом. 
 

 
 
Стежки "Половина креста" 
Стежки "Половина креста" могут быть 
использованы для получения объектов 
"воздушного" вида. Вы можете также 
использовать такие стежки, чтобы создавать 
двухцветные стежки "Полный крест".  См. также 
Комбинация стежков. 
 

 
 две половины креста 
 комбинация для получения  

двухцветного полного креста 
 
Стежки "Четверть креста" 
Стежки "Четверть креста" и "Три четверти 
креста" могут быть использованы для создания 
плавных закругленных углов. Вы можете также 
использовать такие стежки, чтобы создавать 
стежки "Полный крест" с четырьмя цветами. См. 
также Комбинация стежков. 
 
Щелкните здесь, чтобы начать с этого угла 
 
 
 
 

Стежок "Полный крест", созданный из четырех  
четвертей креста разных цветов 
 
См. также Комбинация стежков. 
 
Стежки "Мини крест" 
Используйте стежок "Мини крест" для таких 
деталей, как глаза, или для более плотных 
деталей проекта. 
            

 
четыре мини креста         комбинация для получения  
                                          четырех мини креста 
 
Стежки удлиненного креста 
Удлиненные по горизонтали и вертикали кресты 
создаются из двух равной длины стежков, 
образующих крест.  
 

 
узоры стежка "Удлиненный крест" 

 
Комбинации стежков 
Стежки в четверть, половину и три четверти 
креста можно комбинировать для создания 
составных многоцветных крестов.  
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Вы можете также комбинировать мини кресты, удлиненный по горизонтали или вертикали кресты с 
оконтуривающими стежками. 
 

 
комбинированные стежки  
в 1/4, 1/2 и 3/4 креста 
 
комбинированные стежки  
удлиненного по вертикали или горизонтали креста 
 

комбинированные стежки  
неполного креста и мини креста 
 
комбинированные по цвету  
оконтуривающие стежки 
 
комбинация оконтуривающих  
стежков 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Глава 2: Основные сведения о программе Cross Stitch  

BERNINA
®

 Программа «Вышивка крестом»   6

ГЛАВА 2 
 

ОСНОВНЫЕ СВЕДЕНИЯ О 

ПРОГРАММЕ CROSS STITCH 
------------------------------------------- 

 

 
 
 

В программе BERNINA® Cross Stitch 
вы можете добавлять стежки для 
вышивки крестом в весь проект или в 
отдельный его фрагмент. Или вы 
можете размещать их индивидуально. 
Имеется два типа стежков – оконтуривающие и заполняющие. 
Стежковое оконтуривание может быть однорядным или в виде 
линии стежков для вышивки крестом. Для заполнения можно 
использовать любой тип стежка для вышивки крестом. Вы 
можете заранее установить тип стежка, длину и число 
повторения каждого стежка. 
В этом разделе описывается использование окна проекта 
стежков для вышивки крестом, техника ручного оцифровывания 
стежков и обращение с файлами проектов вышивки крестом. 

 
Введение в вышивку крестом 
BERNINA 
 
 

 Для доступа к вспомогательным 
приложениям – Портфолио, Вышивка 
крестом и Квилтер – используйте Обшее 

> Application Launcher.  
 
Проект вышивки крестом предусматривает 
использование различных приемов 
оцифровывания. По этой причине приложение 
для вышивки крестом имеет собственное окно 
проекта, открывающееся из ПО BERNINA 
Embroidery Software.  
 
Как открыть программу Cross 
Stitch 
1 Запустите ПО BERNINA Emboirdery 

Software. 
2 Выберите режим Embroidery Canvas. 
3 Нажмите на значок Cross Stitch  

 Откроется окно Cross Stitch. 
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Строка заголовка 
Строка  меню 

Общая панель 
инструментов 

Кнопки переключения  
режимов 

 
 
 

Панель 
рисунка/проекта 

 (изменяется при 
 выборе режима) 

 
 
 
 
 
 
 
 
 
 
 
 

Панель 
инструментов  

Stitch and Color  
Строка состояния 

 

Режимы Picture и Design  
 
Нажмите кнопку Picture, 
чтобы загрузить рисунок, 
используемый в качестве 
шаблона. 
Нажмите кнопку Design 
для редактирования и 
добавления стежков. 

 
Программа Cross Stitch использует два режима 
рабочего окна – Picture (Рисунок) и Design 
(Проект).  Используйте режим Picture для 
открытия или сканирования рисунка в качестве 
шаблона вышивки. Отредактируйте рисунок в 
режиме Picture, затем выберите режим Design, 
чтобы редактировать стежки, или перейдите 
сразу же к режиму Design, добавлять стежки без 
использования шаблона. Чтобы увидеть свой 
проект в режиме Artistic, откройте проект в ПО 
BERNINA Embroidery Software. Подробнее см. в 
разделе Использование стежков для вышивки 
крестом. 

Изменение настроек сетки 
 

Нажмите инструмент Grid (панель 
General), чтобы отобразить или скрыть 

сетку. Щелчок правой кнопкой мыши открывает 
диалоговое окно Grid. 
 
Используйте диалоговое окно Options > Grid для 
изменения настроек сетки:  
◄ показать или скрыть сетку 
◄ показать главные линии (если сетка 

включена) 
◄ установить интервал сетки 
◄ изменить цвет главных и второстепенных 

линий 
 
Как изменить настройки сетки 
1 Щелкните правой кнопкой мыши по 
значку Grid (Сетка).
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 Появится диалоговое окно Options с 
открытой закладкой Grid.  
 
  

 
Выберите Show 

Grid 
Выберите Show 

Major  
Lines 

 
Введите число 
крестиков для  

подгонке к сетке 
 
 

Выберите цвета 
линий 

 

2 Проставьте флажок в окошке Show Grid, 

чтобы отобразить линии сетки. 
3 Выберите Show Major Lines, чтобы 

отобразить главные линии сетки. 
4 Введите число крестиков для подгонки к 

главным линиям сетки. 
5 Нажмите Edit для изменения цвета главных 

и 

второстепенных линий сетки.  
 
Выберите цвет 
 
6 Выберите из имеющихся цветов или 

назначьте собственный цвет. 
 Нажмите кнопку Define Custom 

Colors (Определить цвет 
пользователя), чтобы смешать цвета 
из цветового круга. 

7  Нажмите кнопку ОК. 
 
Изменение настроек пялец 
 

Нажмите инструмент Hoop (панель 
General), чтобы отобразить или скрыть 

пяльцы. Щелчок правой кнопкой мыши 
открывает диалоговое окно Hoop. 
 
Вы можете отображать или скрывать пяльцы, 
изменять размеры пялец и центрировать проект 
в пяльцах. 

 
Как изменить настройки пялец 
1 Щелкните правой кнопкой мыши по значку 

Hoop (Пяльцы). 
 Появится диалоговое окно Options с открытой 

закладкой Hoop (Пяльцы).  
 

 
 

Выберите Display 
Hoop 

 
Выберите тип 

пялец 
 
 
 
 
 
2 Проставьте флажок в окошке Display Hoop 

(Отобразить пяльцы). 
3 Выберите тип пялец из списка. 
 

Примечание: Функция Automatic Centering 
(Автоматическая центровка) всегда 
включена. Чтобы создать группу стежков 
установите на одной стороне проекта, 
оцифруйте несколько временных стежков на 
другой стороне. 

4 Нажмите кнопку ОК. 
 
Изменение цветов фона и ткани 
 
ПО BERNINA Embroidery Software дает 
возможность выбирать цвет фона в окне 
проекта, чтобы согласовать его с цветом вашей 
ткани. Или же можно выбрать фон ткани для 
более реалистичного вида и воспроизведения. 
 
Как изменить цвет фона или ткани 

1 Выберите Settings > Options. 
 
2 Выберите закладку Background (Фон). 

 
Правка 
цветности 
 
Выбор 
узора ткани 
 
 
 

Выбор цвета фона  Центровка или мозаичное  
или ткани                      расположение узора ткани  
                                      в окне проекта 
 
3 Выберите окно проекта с типом фона. 

◄ Color (Цвет):  используется выбранный 
цвет. 

◄ Fabric (Ткань): используется образ ткани. 
4 Выберите для использования цвет или ткань. 

◄ Для выбора цвета фона нажмите Edit. 
Выберите цвет в диалоговом окне Color и 
нажмите OK. 

 



Глава 2: Основные сведения о программе Cross Stitch  

BERNINA
®
 Программа «Вышивка крестом» 9 

 
 
 
 
 
 
 
 
 

Выбор 
цвета фона 
 
 
 
 
 
 
 
 
 
 
 

 
◄ Для выбора ткани нажмите Browse 

(Обзор). Выберите тип ткани из 
диалогового окна Open и нажмите OK. 

 

 
 
Выбор ткани фона 

 
 

Вы можете расположить растровый рисунок 
ткани по центру окна проекта или образовать 
мозаичную структуру. Если растровый 
рисунок достаточно большой, выберите 
Center. В противном случае выберите Tile 
(Плиточная кладка).. 

5 Нажмите кнопку ОК.  
 
 
 

Просмотр стежков в виде крестиков 
или плиток 
 

Нажмите инструмент Crosses (панель 
General), чтобы показать стежки в 
виде цветных плиток или крестиков. 
 

Имеется два режима отображения стежков для 
вышивки крестом – в виде крестиков или 
цветных "плиток". Когда вы перейдете к режиму 
Tile, вы увидите тот же результат, когда вы 

импортируете растровое изображение в окно 
проекта. 
 
Как просматривать стежки в виде 
крестиков или плиток 
1 Выберите режим Design. 
2 Нажмите кнопку Crosses (Крестики). 

Все оцифрованные зоны показываются в 
виде крестиков (или линий для линии 
обрамления). 

3 Щелкните еще раз, чтобы показать стежки в 
виде цветных квадратов. 

       
Стежки показаны    

 Стежки показаны  
в виде квадратиков    в виде 

цветных 
                                                   квадратиков 

  

 
Стежки показаны    

 Стежки неполного креста  
в виде квадратиков   

 показаны в виде цветных квадратиков 
 
Просмотр 
информации о 
проекте 
В строке состояния 
показывается 
информация о проекте, 
такую как сведения об 
индивидуальных стежках, 
приблизительное 
количество стежков и 
нитках, используемых в проекте, а также 
масштабный коэффициент. 
 

 
    координаты указателя    количество      масштабный 
                                              стежков           коэффициент  
 

Настройка размера и плотности 
проекта 
 
В программе BERNINA Cross Stitch размер 
проекта контролируется плотностью ткани. 
Например, чем больше стежков на дюйм, тем 
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меньше размеры и тем более компактнее 
проект. Вы можете регулировать плотность 
индивидуальных стежков для вышивки крестом, 
выполняя его один, два или три раза. 
 
Установка размера проекта 
Вы можете установить размер проекта для 
вышивки крестом, регулируя "плотность ткани". В 
действительности этим изменяется масштаб 
вашего окончательного проекта. Например, чем 
больше стежков на дюйм, тем меньше размеры 
и тем более компактнее проект.  
 
Внимание: Общей проблемой проектов для 
вышивки крестом является их "стягивание", 
особенно при использовании мелких и плотно 
расположенных стежков. Проекты для вышивки 
крестом имеют склонность стягивать ткань 
равномерно, с образованием пробелов по 
прямым линиям. Иногда отверстия создают 
впечатление пропуска стежков.  См. также 
Настройка плотности стежков. 
 
Как устанавливать размер 
проекта 
1 Выберите Settings (Настройки) > Fabric 

Count (Плотность ткани).. 
 Откроется диалоговое окно Fabric Count. 
 
 
 

Ввод числа стежков  
на дюйм 

 
Ввод числа стежков  

на мм 
 
 
2 Выберите опцию плотности ткани, в 
дюймах или миллиметрах. 

◄ Число стежков на дюйм: Чем меньше 
стежков на дюйм, тем крупнее готовый 
проект. 

◄ Число миллиметров на число стежков: 
Поскольку стежки для вышивки крестом 
больше миллиметра, вы можете 
настроить проект относительной 
величиной, отношением числа 
миллиметров к числу стежков.  Чем 
больше число миллиметров или меньше 
число стежков, тем крупнее проект. 

 
Совет: При нажатии кнопки Update 
происходит немедленное преобразование 
любой введенной вами величины. Например, 
измените число стежков на дюйм, нажмите 
Update, и соответствующее число стежков 

на мм будет обновлено.  
3 Нажмите кнопку ОК. 

15 стежков на дюйм  10 стежков на дюйм 

     
15 стежков на 25,4 мм  10 стежков на 25,4 мм 

 
Настройка плотности стежков 

 
Используйте список Threads в строке 
Stitch / Color для установки плотности 
стежков. 

 
Вы можете регулировать плотность любого 
стежка для вышивки крестом, выполняя его 
один, два или три раза. Число "пересечений" 
соответствует значениям 2, 4 и 6 в списке 
Threads (Нити). Вы можете изменить эти 
значения в любое время. 
Если вы уменьшаете проект для его подгонки к 
размеру пялец, стежки могут 
накладываться друг на друга и стягивать 
ткань. Вы можете устранить эту 
проблему, сократив число пересечений до 
одного (2 нити) для заполнений и контуров. Вы 
также можете использовать нитки меньшей 
толщины. 
 
Совет: Если вы вышиваете крестом проект, в 
котором каждый квадрат заполняется стежком, 
не забудьте стабилизировать ткань. 
 
Как установит плотность стежков 

◄ Выберите значение из списка Threads. 
Значение 2 соответствует одинарному 
стежка, 4 – двойному, а 6 – тройному. На 
экране это отображается толщиной 
линий. 

                в 2 нитки    
 в 6 ниток 
 

 
Совет: При перемещении указателя мыши по 
стежкам во всплывающей подсказке можно 
узнать о типе и цвете стежка. 

 

Выбор типов стежков для 
вышивки крестом 
 
Программа BERNINA Cross Stitch предоставляет 
полный набор стежков для вышивки крестом, 
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которые вы можете использовать для создания 
контуров и заполнений любого цвета. Вы можете 
также изменять ориентацию неполных стежков-
крестиков для создания различных эффектных 
узоров. 
 
 
Выбор оконтуривающих стежков 
 
Используйте инструмент Outline (панель Stitch & 
Color) для выбора оконтуривающих стежков. 
 

 
Выберите 
оконтуривающий стежок  

                                        из списка Outline Stitch. 
 
Имеется два типа оконтуривающих стежков: 
Single Line (Одиночная линия) и Current Cross 
Stitch (Текущий стежок для вышивки крестом). 
Выберите тип стежка перед выбором опции 
Current Cross Stitch. 
 
Как выбрать оконтуривающий 
стежок 
1 Нажмите кнопку Outline 

(Оконтуривание). 
2 Выберите тип оконтуривающего стежка 
из списка Outline Stitch. 

Новые стежки будут оцифрованы в виде 
одиночных линий или крестиков. Если вы 
используете опцию Current Cross Stitch, будет 
применен выбранный тип стежка для 
вышивки крестом. Подробнее см. в разделе 
Выбор заполняющих стежков. 

    

 
Оконтуривание одиночной  оконтуривания 

крестообразными  
линии    

   стежками 
 
 

Примечание: В зависимости от выбранного 
типа стежка вы можете задать направление 
стежка. Подробнее см. в разделе Настройка 
ориентации стежков для вышивки крестом. 
 

Выбор заполняющих стежков 
 

Используйте инструмент 
Fill на панели Stitch / 
Color для выбора 
заполняющих стежков. 
Щелкните по кнопке Fill 
Cross, чтобы открыть 
карту Fill Stitch. 
 

В качестве заполняющих используются все типы 
стежков для вышивки крестом. Выберите нужное 
из следующих типов: Full Cross (Полный крест), 
Three-quarter Cross (Три четверти креста), Half 
Cross (Половина креста), Quarter Cross 

(Четверть креста), Mini Cross (Мини крест), 
Upright Cross (Прямой крест), Double Cross 
(Двойной крест), Elongated Vertical Cross 
(Удлиненный по вертикали крест) и Elongated 
Horizontal Cross (Удлиненный по горизонтали 
крест). См. Заполнение стежками для вышивки 
крестом в Руководстве пользователя. 
 
Как выбрать заполняющий стежок 
1 Нажмите кнопку Fill (Заполнить). 
2 Щелкните правой кнопкой мыши по 
кнопке Fill Cross. 
 

Совет: Если вы хотите, чтобы диалоговое 
окно Select Stitch (Выбор стежка) оставалось 
открытым, щелкните правой кнопкой мыши по 
кнопке Fill Stitch (Заполняющий 
стежок).  

 
Кнопка Fill Stitch 

 
Откроется карта Select Stitch (Выбор 
стежка). 

 
 

3 Выберите тип стежка. 
Стежки будут оцифрованы с этим типом 
стежков. Карта Select Stitch (Выбор стежка) 
закроется. 

4 В зависимости от выбранного типа стежка вы 
можете задать направление стежка. 
Подробнее см. в разделе Настройка 
ориентации стежков для вышивки крестом. 

 
 

Различные 
эффекты 

заполнения 
стежками для 

вышивки крестом 
 

 
 
 
 
 
 
 
Настройка ориентации стежков для 
вышивки крестом. 
Вы можете также изменять ориентацию 
неполных стежков-крестиков для создания 
различных эффектных узоров. 
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При оцифровывании индивидуальных стежков 
вы делаете это непосредственно квадрат за 
квадратом. При оцифровывании заполнения для 
этого нужно пользоваться диалоговым окном 
Select Fill Style (Выбор типа заполнения). 
Способ остается тем же. См. Типы стежков для 
вышивки крестом в Руководстве пользователя. 
 

 
 
 
Щелкните по 
заполняемому 
квадранту  
 
 
 
 

 
Как установить ориентацию 
стежков для вышивки крестом 
◄ Для создания стежков в три четверти креста 

щелкните по углу, в котором должен 
образоваться этот стежок. 

    
 

◄ Для создания стежка в половину креста 
щелкните по углу, в котором должен 
образоваться этот стежок. 

                                  
 
 
 
 
 
Щелкните здесь для   
 Щелкните здесь для 
создания стежка "/"              создания стежка "\" 
 
◄ Для создания стежка в четверть креста 

щелкните по углу, в котором должен 
образоваться этот стежок. 

 
Щелкните здесь, 
чтобы начать с этого 
угла 
 
 

◄ Для создания стежка мини крест щелкните 
по углу, в котором должен образоваться этот 
стежок. 

 
Щелкните здесь 
для помещения 
стежка в этом 
углу 
 
 

 
 
 
◄ Для создания стежка удлиненного креста 

щелкните по углу, в котором должен 
образоваться этот стежок. 

 
Щелкните здесь для помещения стежка на этой 

стороне 

           

 

Выбор цвета стежков 
 
 
Используйте Color Palette (панель Stitch & Color) 
для выбора цвета стежков. 
 
Вы можете выбирать цвет стежков из Color 
Palette (Палитра цветов) до оцифровывания 
или применить новый цвет для выбранных зон.  
 
Как выбрать цвет стежка 
1 Щелкните правой кнопкой мыши по 
палитре цветов, чтобы открыть ее. 
 

Совет: Если вы хотите, чтобы панель Select 
Thread Palette (Панель выбора нитки) 
оставалась открытой, щелкните правой 
кнопкой мыши по кнопке Stitch Type (Тип 
стежка). 

2 Выберите цвет: 
◄ Выберите цвет из 

палитры цветов, 
чтобы применить его к заново 
оцифровываемым объектам. 

◄ Выберите блок стежков, затем выберите 
цвет для изменения первоначального 
цвета.  

 
     Палитра 
цветов 

 
Стежки будут оцифрованы в этом цвете.  

 
Совет: Вы можете перетащить палитру 
Select Thread Palette в любое удобное для 
вас место экрана.   

 
Поиск типов ниток 
 
Вы можете найти нитку по коду или описанию в 
диалоговом окне Thread Colors (Цвета ниток) и 
добавить ее к выбранным цветам проекта. В 
представленных таблицах приводятся марки 
фирменных ниток, поддерживаемых BERNINA 
Cross Stitch.  В каждой таблице дается диапазон 
цветов различных ниток. Отображаются код, 
марка и описание каждого цвета, так что вы 
можете легко найти требуемые нитки в 
специализированных магазинах. Вы можете 
найти цвета по оттенку или по номеру. Выберите 
таблицу ниток для марки ниток, имеющихся у вас 
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дома, или ту таблицу, цвета которых вам больше 
всего нравятся.  
 
 

 
Внимание: Воспроизведение цвета в таблицах 
фирменных ниток является приблизительным, и 
компьютерная имитация не предназначена для 
точного подбора цвета ниток.   
 
Как найти тип нитки 
1 Выберите Settings (Настройки) > Thread 

Colors (Цвета ниток). 
 
 Откроется диалоговое окно Thread 
Colors. 
 
 
 
 

          
 
 
 
 

 Выбор таблицы 
ниток 

                   
Подбор кода 

              
 
 
 

Ввод поисковой 
строки 

   
 

                                                              Выбор кода нитки 
 
2  Выберите таблицу ниток, чтобы включить в 

поиск из списка Thread Charts (Таблицы 
ниток). 

3  Выберите функцию поиска – Code (Код) или 
Description (Описание). 

 Код – это идентификационный номер цвета 
нитки в бренде. 

4  В поле Search (Поиск)  введите первые 
несколько символов требуемого кода или 
описания. 

 Система разыщет наиболее близкое 
соответствие и отобразит его в списке цветов 
нитки. 

 
5  Выберите цвет на панели  Threads in Design 

и щелкните по Assign. 
6  Щелкните по OK, чтобы закрыть окно.. 
 
Примечание: Выбранные настройки цвета 
применяются только к текущему проекту и 
являются частью "свойств проекта". В таком 
виде они сохраняются вместе с проектом. 
 
Смешивание ваших собственных 
цветов ниток 
 
Вы можете изменить цвет, который 
отображается для частичной нитки или создайте 
новые цвета ниток, используя диалоговое окно 
Color (Цвет). 
 

Как смешивать ваши собственные 
цвета ниток 
1  В диалоговом окне Thread Colors щелкните 

по Edit .  
2  Откроется диалоговое окно Edit Thread  
     (Редактировать нитку).. 

 
                           Щелкните по Mix (Смешать). 
 

3  Щелкните по Mix (Смешать). 
 
 

 Откроется окно Color (Цвет).. 
 

 
 
 

4  Щелкните по Define Customs Colors, чтобы 
открыть палитр цветов.  

5  Из таблицы Basic colors (Основные цвета) 

выберите цвет, который ближе всего 
подходит к нужному вам цвету. 

6  Щелкните мышью и перетащите перекрестие 
нитей по спектру цветов, чтобы получить 
требуемый вам цвет. 

7  Передвиньте ползунок на правой стороне 
окна цветового спектра, чтобы 
отрегулировать яркость цвета. 

 В правом нижнем углу диалогового окна Color 

появятся значения HLS (Цвет-Яркость-
Насыщенность) и RGB (Зеленый, Красный, 
Синий). Введите эти значения для точного 
определения цветов. 

8  После смешивания требуемого цвета 
Щелкните по Add to Custom Colors 
(Добавить к пользовательским цветам). 

9  Щелкните по ОК. 
Новый цвет появится в окне просмотра Color  
(Цвет). 

Оцифровывание стежками для 
вышивки крестом 
 
Программа BERNINA Cross Stitch предоставляет 
различные технические приемы для 
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оцифровывания одиночных стежков или рядов 
стежков, заполненных и не заполненных 
прямоугольников или окружностей или  
заполненных и не заполненных "закрытых" 
произвольных форм. Вы можете также создавать 
контуры или обрамления произвольной формы. 
Функция Area Fill (Заполнение формы) позволяет 
заполнять стежками закрытые  формы или 
"цветовые блоки".  
 
Оцифровывание одинарных стежков 
или рядов стежков 
 

Используйте инструмент Pencil (панель 
Design), чтобы нарисовать одинарный 

стежок или ряд стежков. 
 
Вы можете оцифровывать одинарный стежок 
или ряд стежков. В зависимости от выбранного 
типа стежка вы должны также задать 
направление стежка. См. также Создание 
комбинации стежков. 
 
Как оцифровать одинарный 
стежок или ряд стежков 
1 Щелкните по Outline (Оконтуривание) и 
выберите тип оконтуривающего стежка. 

Если вы используете опцию Full Cross, будет 
применен выбранный тип стежка для 
вышивки крестом. См. также Выбор 
заполняющих стежков. 

2 Выберите цвет из цветовой палитры. 
Подробнее см. в разделе Выбор цвета 
стежков. 

3 Нажмите кнопку Pencil (Карандаш). 
4 Щелкните по квадрату, чтобы создать 

одинарный стежок, или перетащите 
карандаш, чтобы нарисовать линию. 

 
Примечание: Нажмите Ctrl перетаскивайте 
инструмент, чтобы получать прямые 
вертикальные линии. 

 
 
 
Одинарные стежки и 
линии 
 
 
Совет: Вы можете 
также использовать 
инструмент Pencil 

для создания комбинаций неполных крестов 
разного цвета. См. также Создание 
комбинации стежков. 

 
Оцифровывание окружностей 
 

Используйте инструмент Circle (панель 
Design) для оцифровывания окружностей. 

 
Инструмент Circle ( Окружность) позволяет 
быстро оцифровывать заполненные или не 
заполненные окружности. 
 
Как оцифровывать окружность 
1 Нажмите кнопку Circle (Окружность). 

2 Выберите цвет из цветовой палитры. 
Подробнее см. в разделе Выбор цвета 
стежков. 

3 Выберите тип стежка Outline 

(Оконтуривающий) или Fill (Заполняющий). 
Подробнее см. в разделе Выбор типов 
стежков для вышивки крестом. 

4 Наметьте точку центра и затем точку на 
окружности. 
 

◄ Если вам нужна окружность, нажмите 
Enter дважды. 

◄ Если вам нужен эллипс, наметьте третью 
контрольную точку и нажмите Enter. 

Окружность или овал заполняются или 
оконтуриваются в зависимости от выбранного 
типа стежка. 

 

 
Обрамление стежком 
"Полный крест 

Обрамление стежком 
"Полный крест" 

 
Заполнение стежком "Три 
четверти креста" 

Заполнение стежком 
"Половина креста" 

 
Оцифровывание прямоугольников 

 
Используйте инструмент Rectangle 
(панель Design) для оцифровывания 
прямоугольников или квадратов. 

 
Инструмент Rectangle (Прямоугольник.) 
позволяет быстро оцифровывать заполненные 
или не заполненные прямоугольники или 
квадраты. 
 
Как оцифровывать 
прямоугольник 
1 Щелкните по значку Rectangle 

(Прямоугольник). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета 
стежков. 

3 Выберите тип стежка Outline 

(Оконтуривающий) или Fill (Заполняющий). 
Подробнее см. в разделе Оцифровывание 
стежками для вышивки крестом. 

4 Наметьте начало объекта, а затем угол 
прямоугольника. 

Нажмите Ctrl и наметьте углы, чтобы 
оцифровать квадрат.  Квадрат или 
прямоугольник заполняются или 
оконтуриваются в зависимости от выбранного 
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типа стежка. Подробнее см. в разделе 
Оцифровывание прямоугольников.  

 
Примечание: В зависимости от выбранного типа 
стежка вы можете задать направление стежка. 
Подробнее см. в разделе Создание комбинации 
стежков. 
 

 
Обрамление 

стежком 
«Одиночная линия» 

Обрамление 
стежками 

полного креста 
Заполняющие 

стежки 
  
  
Оцифровывание открытых и 
закрытых форм 

 
Используйте инструмент Closed Curve 
(панель Design), чтобы рисовать и 
оцифровывать замкнутые фигуры. 
 
Используйте инструмент Open Curve 
(панель Design), чтобы рисовать и 
оцифровывать незамкнутые фигуры. 
 

Вы можете создавать произвольной формы 
контуры или обрамления, используя инструмент 
Open Curve (Незамкнутая кривая). Вы можете 
создавать произвольные заполняемые формы, 
используя инструмент Closed Curve (Замкнутая 
кривая). Выберите оконтуривающий стежок для 
не заполняемых форм и заполняющий стежок 
для заполняемых форм. 
 
Как оцифровывать незамкнутую 
или замкнутую фигуру 
1 Нажмите на кнопку Open Curve ( 

Незамкнутая кривая) или Closed Curve 
(Замкнутая кривая). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета 
стежков. 

3 Выберите тип стежка Outline 

(Оконтуривающий) или Fill (Заполняющий). 
Подробнее см. в разделе Выбор типов 
стежков для вышивки крестом. 

4 Наметьте базисные точки вашего 
проекта. 

Щелкайте левой кнопкой мыши для острых 
углов и правой кнопкой для округленных 
углов. 

5 Нажмите Enter. 

 
Форма заполняется или оконтуривается в 
зависимости от выбранного типа стежка. 

 
 
Намеченные  
базисные точки. 
 
 
 
 
 
Оконтуренная 
одиночной 
линией 
незамкнутая 
форма 
 
Оконтуренная 
одиночной 
линией 
замкнутая 
форма 
 
  
 

Заполненные цветовые блоки  
 
Используйте инструмент Area Fill (панель 
Design) для заполнения стежками закрытых  

         форм или цветовых блоков. 
 
Закрытые зоны заполняются стежками 
инструментом Area Fill (Заполнение формы). Вы 
можете также использовать этот инструмент для 
изменения цвета и типа стежков контуров, 
выполняемых стежком Full Cross.  
 
Примечание: Инструмент Area Fill работает 
только со слоями стежков для вышивки крестом. 
Этот инструмент не работает с растровыми 
изображениями, используемыми в качестве 
фона.  
 
Как заполнять цветовые блоки 
1 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета 
стежков. 

2 Выберите тип заполняющего стежка. 
Подробнее см. в разделе Выбор 
заполняющих стежков. 

3 Нажмите кнопку Area Fill (Заполнить 

форму). 
4 Щелкните в пределах закрытой формы. 

Форма будет заполнена стежками 
выбранного типа и цвета. 
   

 
Оцифровано инструментом   Цвета изменены  
              Auto Digitizer                  инструментом Area Fill 

 

Оконтуренная  
стежком  
полного креста 
незамкнутая  
форма 

Оконтуренная  
стежком  
полного креста 
замкнутая форма 
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Внимание: Инструмент Area Fill не работает 
в формах с оконтуриванием одинарным 
стежком, некоторые формы с угловыми 
линиями могут быть заполнены неправильно. 
Попробуйте создать контур из двух 

рядов перекрестных стежков. 

Обращение с файлами 
проектов со стежками для 
вышивки крестом 
 
Проекты со стежками для вышивки крестом 
имеют собственный ARX-формат. Они могут 
быть считаны в ПО BERNINA Embroidery 
Software. Вы также можете комбинировать ARX-
файлы с проектами в других форматах. 
 
Сохранение проектов со стежками 
для вышивки крестом 

 
Используйте кнопку Save (панель General) 
для сохранения файлов программы  

           Cross Stitch.  
 
Сохраняйте проект во время работы, как можно 
чаще. Для сохранения файлов со стежками для 
вышивки крестом используйте расширение ARX. 
 
Как сохранить проект со стежками 
для вышивки крестом 
1 Выберите File > Save. 

Если вы сохраняете проект в первый раз, 
откроется диалоговое окно Save As 
(Сохранить как …). Файл следует сохранить 
как ARX-файл. 
 

2 Из списка Files of Types (Тип файла) 

выберите cross stitch (ARX). 
    

Примечание: Вы можете сохранить проект 
только в формате ARX. 
3 Введите новое имя для проекта и 
нажмите Save. 
 
 
Использование программы 
вышивки крестом 

BERNINA
®

 Embroidery 
Software  
Обрвзцы дизвйна выщивки крестом 
сохраняются в формате ARX. Этот формат 

напрямую поддерживается BERNINA 

Embroidery Software и может быть 
совмещен с другими видами выщивки. 
 
 
Как использовать стежки для 
вышивки крестом в ПО BERNINA 
Embroidery Software 
1 Запустите ПО BERNINA Embroidery 
Software. 
2 Выберите File > Open. 

Откроется диалоговое окно Open. 

 
     

3 Выберите файлы ARX из списка Files of Type 

(Тип файла). 
4 Выберите ваш файл. 
5 Нажмите Open. 
Проект будет отображен в том виде,  
в котором он будет вышит. 
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ГЛАВА 3 
 

РЕДАКТИРОВАНИЕ В ПРОГРАММЕ 

CROSS STITCH 
------------------------------------------- 

 
 

Программа BERNINA Cross Stitch предоставляет 
технические возможности редактирования проектов 
вышивки крестом, включая перемещение, вращение и 
перевод в зеркальное отображение блоков стежков. 
Вы можете удалять стежки, а также изменять 
цветность и тип стежков в выбранных фрагментах. Вы 
можете клонировать выделенные объекты для их 
повторного использования в виде "резинового 
штампа" и заполнять большие формы мотивами или 
специальными композициями стежков. Вы можете также 
редактировать стежки для создания комбинаций неполных крестов 
разного цвета. 
В этом разделе дается подробная информация о функциях 
редактирования стежков для вышивки крестом. 

 

Выбор и блокирование стежков 
 
Для редактирования фрагмента проекта, вы 
должны вначале его выделить. Программа 
BERNINA Cross Stitch предоставляет несколько 
способов выделения стежков. Она также дает 
возможность блокировать стежки для вышивки 
крестом и/или контуры, чтобы их нельзя было 
случайно переместить или изменить. 
 
Выбор стежков для вышивки 
крестом инструментом Select Object 
или Polygon Select 
 

Используйте инструмент Select Object 
(панель Design), чтобы выбрать 
одиночный стежок или блок стежков. 
 
 
Используйте инструмент Polygon Select 
(панель Design), чтобы выбирать 

фрагменты или формы с нерегулярными 
контурами.  
 
Инструменты Select Object (Выбор объекта) и 
Polygon Select (Выбор многоугольником) 

работают таким же образом, как в ПО BERNINA. 
Различие заключается в том, что в программе 
BERNINA Cross Stitch вы работаете с блоками 
стежков или фрагментами, а не с объектами 
проекта. 
 
Внимание: Вы не можете выбирать стежки для 
вышивки крестом за пределами пялец. 
 

Как выбирать стежки для 
вышивки крестом инструментом 
Select Object или Polygon Select 
◄ Инструментом Select Object (Выбор 

объекта) нужно просто обвести 
ограничивающий прямоугольник вокруг 
выделяемого фрагмента. 
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◄ Инструментом Polygon Select (Выбор 

многоугольником) нужно наметить базисные 
точки вокруг выделяемого фрагмента и 
нажать Enter. 

 
              

 
Использован инструмент   Удалены 
заполняющие 
Select Object     
 стежки 
              

 
Использован инструмент   Удалены 
заполняющие 
Polygon Select      стежки 
 

Совет: Удерживайте нажатой клавишу Ctrl 
для выбора нескольких фрагментов. 

 
Выбор стежков для вышивки 
крестом инструментом Auto Select 
 

Используйте инструмент Auto Select 
(панель Design) для выбора одиночных 

цветовых блоков или не оцифрованного 
фрагмента.  
 
Инструмент Auto Select (Автоматический 
выбор) является специфичной функцией 
программы BERNINA Cross Stitch. Он позволяет 
выбирать одиночные цветовые блоки или не 
оцифрованный фрагмент. Выбираются только 
связанные стежки одного цвета. 
 
Как выбирать стежки для 
вышивки крестом инструментом 
Auto Select 
1 Щелкните по значку Auto Select. 
2 Щелкните по блоку стежков. 

Выбираются только связанные стежки одного 
цвета. 

 
Совет: Удерживайте нажатой клавишу Ctrl для 
выбора нескольких блоков. 
     

 
Выбранный цветовой блок  Удерживайте нажатой 

клавишу Ctrl для выбора 
блоков желтого цвета 

 
Совет: Вы можете изменить цвет всех 
выделенных стежков, выбрав цвет из палитры. 
 
Блокирование стежков 
Вы можете блокировать стежки для вышивки 
крестом и/или контуры, чтобы их нельзя было 
случайно переместить или изменить. 
 
Как блокировать стежки 
1 Выберите Edit > Crosses или Edit > 

Outlines. 
Если в меню выбрано Crosses, то могут быть 
перемещены стежки для вышивки крестом. 
Подобным же образом, если выбрано 
Outlines, то могут быть перемещены контуры.  
 

2 Выберите фрагмент, щелкните по нему и 
перетащите, чтобы переместить стежки. 

 
 
Выбранный проект  
содержит контур и  
заполняющие стежки  
для вышивки крестом 
 
 
 
 
 
 
Команда Edit > 
Crosses не  
выбрана, при 
перетаскивании  
фрагмента 
перемещаются  
только контуры 
 
 
3 Снова выберите Crosses или Outlines, чтобы 

убрать флажки и заблокировать все стежки 
или контуры.  

 

Простое редактирование 
стежков 
 
Программа BERNINA Cross Stitch позволяет в 
любое время изменять цвет или тип выбранных 
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блоков стежков. Вы можете также в любое время 
удалять стежки. 
 
Подробнее см. в разделе Выбор цвета стежков. 
Вы можете также смешивать собственные цвета, 
которые более точно соответствуют требуемым 
цветам проекта. Подробнее см. в разделе 
Создание собственных таблиц ниток в 
Руководстве пользователя. 
 
Копирование, вырезание и вставка 
блоков стежков 
 

Используйте инструмент Copy (панель 
General), чтобы копировать выделенные 
блоки стежков в буфер обмена. 
 
Используйте инструмент Cut (панель 
General), чтобы вырезать выделенные 
блоки стежков в буфер обмена. 
 
Используйте инструмент Paste (панель 
General), чтобы вставить скопированные 
блоки стежков из буфера обмена. 

 
Вы можете копировать, вырезать и вставлять 
выбранные блоки стежков в любое время. 
Различие заключается в том, что в программе 
BERNINA Cross Stitch вы работаете с блоками 
стежков или фрагментами в большей мере, чем 
с объектами проекта. См. также Заполнение 
резиновым штампом. 
 
Как копировать, вырезать и 
вставлять блоки стежков 
1 Выберите блок стежков для копирования или 

вырезания. 
 Подробнее см. в разделе Выбор и 

блокирование стежков. 
2 Нажмите кнопку Copy (Копировать) или Cut 

(Вырезать). 
 Выбранный фрагмент или фрагменты будут 

скопированы в буфер обмена. 
3 Нажмите кнопку Paste (Вставить). 
 Дублированный фрагмент будет вставлен 

сверху в выбранный фрагмент. 
 

4 Щелкните и переместите вставленный 
блок стежков.    

 
 
Совет: Дублируйте и поворачивайте блоки 
стежков для создания узоров. Подробнее см. в 
разделе Преобразование блоков стежков. 
 
Изменение настроек блока стежков 

 
Используйте инструмент Auto Select 
(панель Design) для изменения цвета 
или типа блока стежков.  

 
Вы можете в любое время изменять цвет и/или 
тип стежка в выбранном блоке. 
 
Как изменять настройки блока 
стежков 
1 Используйте инструмент Auto Select 

(Автоматический выбор)  для выбора 
цветового блока или блоков.  

Подробнее см. в разделе Выбор стежков для 
вышивки крестом инструментом Auto Select. 
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Совет: Удерживайте нажатой клавишу Ctrl 
для выбора нескольких блоков. 

2 Выберите новый цвет из цветовой 
палитры. 

Выбранный цвет заполнит выбранный 
фрагмент. Фрагмент останется выделенным. 

    

 
Выбранный блок стежков  Цвет изменен 

 
3 Выберите новый тип стежка из панели  
      Stitch (Стежок). 

Выбранный тип стежка заполнит выбранный 
фрагмент. 

 
Стежки полного креста    Стежки неполного стежка 

 
Стирание заполнения и одиночных 
линий 
 

Используйте инструмент Eraser (панель 
Design) для стирания заполнений и 
одиночных линий.  

 
Используйте инструмент Eraser (Ластик) для 
удаления стежков.  Этим инструментом 
удаляются заполняющие стежки или одиночные 
линии обрамления в зависимости от выбранного 
типа стежка. Обрамляющие стежки для вышивки 
крестом обрабатываются как заполняющие 
стежки. 
 
Внимание: Вы не можете выбирать и стирать 
стежки для вышивки крестом за пределами 
пялец. 
 
Как стереть заполнение или 
одиночную линию 
1 Щелкните по значку Eraser (Ластик). 
2 Выберите Fill (Заполнить) на панели 

Stitch/Color  
3 Перетащите указатель мыши по стежкам, 

которые нужно удалить. 
 Будут удалены только заполняющие стежки. 

Все одиночные линии обрамления останутся. 

       

Перетащите указатель мыши   Стерты 
только  
по стежкам для их удаления  

 заполняющие линия 
    стежки, 
обрамления  

    
 останется 
 

 Совет: Вы можете также удалять стежки для 
вышивки крестом, выделив их и нажав 
клавишу Delete. 

4 Выберите Outline (Оконтурить) на панели 
Stitch/Color  

5 Щелкните где-либо по одиночной линии. 
 Линия будет удалена. Стежки для вышивки 

крестом не будут стерты. 
 
    

 
Щелкните по линии для удаления  Линия 

стерта 
 
 Примечание: Обрамление одиночной линией 

удаляется одним щелчком. 

Преобразование блоков 
стежков 
 
Программа BERNINA Cross Stitch позволяет 
производить различные преобразования на 
выбранных блоках стежков для вышивки 
крестом. Вы можете перемещать их, 
поворачивать по часовой стрелке или против 
часовой стрелки. Вы можете также зеркально 
отображать блоки стежков, переворачивая их по 
горизонтали или по вертикали. 
 
Перемещение блоков стежков для 
вышивки крестом 
Вы можете перемещать блоки стежков для 
вышивки крестом в любое время. 
 
Как перемещать блоки стежков 
для вышивки крестом 
1 Выберите блок стежков для перемещения. 
 Подробнее см. в разделе Выбор и 

блокирование стежков. 
2 Перетащите его мышью в новое положение. 
 

Выбранный фрагмент 
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Фрагмент перемещен 

 
Вращение блоков стежков для 
вышивки крестом 

 
Используйте инструмент 90° CW/CCW 
(панель Design), чтобы повернуть 

выбранные стежки.  Для поворота по часовой 
стрелке щелкните по нему левой кнопкой мыши. 
Щелчок правой кнопкой – поворот против 
часовой стрелки. 
 
Вы можете поворачивать блоки стежков для 
вышивки крестом по часовой стрелке или против 
часовой стрелки. Дублируйте и поворачивайте 
блоки стежков для создания узоров. 
 
Как вращать блоки стежков для 
вышивки крестом 
1 Выберите блок стежков для вращения. 
 Подробнее см. в разделе Выбор и 

блокирование стежков. 
2 Щелкните по значку Rotate 90° CW/CCW. 
 

       
Перевод в зеркальное отображение 
блоков стежков для вышивки 
крестом 

 
Щелкните по инструменту Mirror 
Horizontal (панель Design) для 
переворачивания выбранных стежков по 
горизонтали. 
Щелкните по инструменту Mirror Vertical 
для переворачивания выбранных 
стежков по вертикали. 

 
Вы можете зеркально отображать блоки стежков, 
переворачивая их по горизонтали или по 
вертикали. 
 
Как переводить в зеркальное 
отображение блоки стежков для 
вышивки крестом 
1 Выберите блок стежков для перевода в 
зеркальное отображение. 

Подробнее см. в разделе Выбор и 
блокирование стежков. 

2 Щелкните по значку Mirror Horizontal 

(Зеркальное отображение по горизонтали). 

     
                         Переворот по вертикали
 Переворот по  
    
   горизонтали 
 

Совет: Для перевода в зеркальное 
отображение всего проекта выберите 
команду Arrange > Mirror Horizontal/Mirror 
Vertical. 

Специальная техника 
редактирования 
 
Программа BERNINA Cross Stitch располагает 
рядом технических приемов редактирования, 
специально предназначенных для 
оцифровывания стежков для вышивки крестом. 
Вы можете клонировать выделенные объекты 
для их повторного использования в виде 
"резинового штампа" и заполнять большие 
формы мотивами или специальными 
композициями стежков. Вы можете 
комбинировать стежки с неполным крестом 
различными способами. Вы можете также 
добавлять обрамления из крестообразных 
стежков или одиночных линий, а также из обоих 
типов стежков к фрагментам проекта. 
 
Заполнение резинового штампа 

 
Используйте инструмент Rubber Stamp 
(панель Cross Stitch) для клонирования  

             стежков. 
 
Клонируйте выделенные объекты для их 
повторного использования в виде "резинового 
штампа" и заполнения больших форм мотивами 
или специальными композициями стежков. 
 
Как заполнять резиновый штамп 
1 Щелкните по значку Select Object (Выбор 

объекта) и выберите фрагмент для 
клонирования. 

2 Щелкните по значку Rubber Stamp 

(Резиновый штапм). 
 Выбранный фрагмент будет скопирован и 

присоединен к указателю мыши. 
3 Щелкайте "штампом" столько раз, сколько 

вам требуется. 
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Мотив, созданный   Использован "резиновый 
штамп“ 
для обрамления        
 
4 Нажмите Esc или выберите другой 

инструмент, чтобы отключится от функции 
Rubber Stamp. 

 

Создание комбинации стежков 
 
Используйте инструмент Pencil (панель 

Cross Stitch) для добавления комбинации 
стежков. 
 
Стежки в четверть, половину и три четверти 
креста можно комбинировать для создания 
составных многоцветных крестов. Вы можете 
также комбинировать мини кресты, удлиненный 
по горизонтали или вертикали кресты с 
оконтуривающими стежками. См. Вариации 
стежка для вышивки крестом в Руководстве 
пользователя. 
 
Как создать комбинацию стежков 
1 Выберите Edit > Insert. 

Опция Insert (Вставить) помечена флажком 
в меню. При выбранной опции Insert вы 
можете добавлять в квадрат больше одного 
стежка. В противном случае новый стежок 
заменит существующий стежок. 

 
Совет: При выбранной опции Insert в строке 
состояния появляется слово Insert. В 
противном случае появляется Overwrite. 

2 Выберите тип стежка 
 Подробнее см. в разделе Выбор 

заполняющих стежков. 
3 Выберите цвет из цветовой палитры. 
 Подробнее см. в разделе Выбор цвета 

стежков. 
4 Нажмите кнопку Pencil (Карандаш). 
5 Щелкните в том месте, где вы хотите 

вставить стежок. 
 

 
Щелкните по верхнему левому углу,  
чтобы  вставить мини крест 
 
затем щелкните по верхнему правому 
углу,  
чтобы вставить 1/2 креста 
 
затем щелкните по нижнему правому 
углу,  
чтобы вставить 1/4 креста 

 
 
 Примечание: Если вы не выбрали опцию 

Insert, будет заменен весь стежок. 
6 Повторяйте эти операции столько раз, 

сколько требуется. 
 
Добавление обрамлений к 
существующим фрагментам 
Можно добавлять обрамления из 
крестообразных стежков или одиночных линий, а 
также из обоих типов стежков к фрагментам 
проекта. 
 
Как добавлять обрамления к 
выбранным фрагментам 
1 Выберите значок Outline (Оконтуривание). 
2 Щелкните по значку Area Fill (Заполнить 

фрагмент) и затем внутри фрагмента. 
 Линия оконтуривающих стежков добавляется 

вокруг краев выделенного фрагмента. 
 
 Совет: Щелкните еще раз по выбранному 

фрагменту, чтобы добавить другую линию 
стежков внутри первой линии. 

 
 
 

Без обрамления 
 
 
 
 
 
Обрамление 
стежком  
 
 
 
 
 
 
 
 
 
 
 

. 
Обрамление стежком "Двойной крест" "Одиночная 
линия" 
 
Совет: Для комбинирования стежков крестом с 
линейным обрамлением выберите тип стежка 
Full Cross и Flood Fill, затем выберите Single Line 
и Flood Fill опять 
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ГЛАВА 4 
 

ПРОГРАММА CROSS STICH ДЛЯ 

ОПЫТНЫХ ПОЛЬЗОВАТЕЛЕЙ 
------------------------------------------- 
 
 
 
 
 
 
 

Окно проекта программы BERNINA Cross 
Stitch позволяет также импортировать 
рисунки для использования в качестве 
оригинала-шаблона или для автоматического 
оцифровывания. Вы можете также создавать 
тексты стежками для вышивки крестом. 
В этом разделе приводится подробная 
информация о более сложных функциях программы Cross Stitch, 
включая автоматическое оцифровывание и вышивание текстов. 

 

Оцифровывание с оригиналом 
 
В программу BERNINA Cross Stitch можно 
вставлять или сканировать рисунки для 
использования в качестве оригинала для 
оцифровывания. Вы можете автоматически 
оцифровывать оригинальный рисунок, используя 
функцию Auto Stitch. Используйте растровые 
рисунки чистых цветов для создания цветовых 
блоков стежков для вышивки крестом. 
 
Совет: Если нужно изменить размеры или 
повернуть изображение, то лучше делать это во 
время сканирования. Последующее изменение 
размера может разрушить изображение. 
 
Вставка растровых изображений 
 

Используйте инструмент Load Picture 
(панель Picture) для открытия 
изображения. 
 
Используйте инструмент Scan (панель 
Picture) для сканирования изображения. 
 

 
Вы можете вставлять растровые изображения в 
различных форматах для использования в 
качестве оцифровываемых трафаретов. См. 
Поддерживаемые форматы рисунков и 
изображений в Руководстве пользователя. 
 
Как вставить изображения 
1 Нажмите кнопку New (Создать). 
 Откроется новый файл. 
2 Нажмите кнопку режима Picture, чтобы 

открыть изображение.  
3 Нажмите кнопку Load Picture (Загрузить 

изображение). 
 

 Откроется диалоговое окно Open Design 
(Открыть проект). 

    

 
4 Выберите папку из списка Look In. 
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5 Выберите тип файла из списка Files of Type 

(например, BMP). 
6 Выберите файл, который вы хотите вставить. 
 
 Совет: Проставьте флажок в окошке Preview, 

чтобы просмотреть выбранный файл. 
7  Нажмите Open. 
8  Переместите рисунок, так чтобы он 

поместился в пяльцах, или измените размер 
пялец. Подробнее см. в разделе Изменение 
настроек пялец. 

 
 Примечание: Фрагменты за пределами 

пялец не будут вышиты. 
 
Просмотр или скрытие растровых 
изображений 
 

Щелкните по инструменту Picture 
(панель General ), чтобы отобразить 
или скрыть рисунок. 
 

Вы можете просматривать или временно 
скрывать растровый оригинал во время 
оцифровывания в режиме Design. 
 
Как просмотреть или скрыть 
растровое изображение 
◄ Щелкните по значку Picture (Рисунок), чтобы 

просмотреть изображение. 
◄ Щелкните еще раз, чтобы скрыть 

изображение. 
 
  

 
отображаемый рисунок      скрытый рисунок 

 
Масштабирование и преобразование 
растровых изображений 
 
Вы можете изменять размеры и форму 
изображений, загруженных в ПО BERNINA Cross 
Stitch. Однако, если нужно изменить размеры 
или повернуть изображение, то лучше делать 
это во время сканирования. Последующее 
изменение размера может исказить 
изображение. См. Расположение и 
трансформация объектов Objects в Руководстве 
пользователя. 
 
Как масштабировать и 
преобразовывать растровые 
изображения 
1 Вставьте изображение. 

Подробнее см. в разделе Вставка растровых 
изображений. 

2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните по изображению. 

Вокруг изображения появятся восемь 
маркеров изменения формы. Нажмите на 

изображение и растягивайте, так же как и 
любые другие объекты. 

 
Подробности в  Измениние размера 

изображений. 
 

     

 
Маркеры изменения размера   Маркеры 
изменения формы 
 

4 Щелкните по изображению опять. 
Вокруг изображения появятся восемь 
маркеров изменения формы.  

../Мои%20документы/Downloads/transform%20objects.pdf
../Мои%20документы/Downloads/transform%20objects.pdf
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Щелкните и переместите их для вращения 
или перекоса изображения, как и для других 
объектов. См. разделы Вращение объектов и 
Перекос объектов в Руководстве 
пользователя. 

     

 
Изменение размера    
 Изменение 
изображения     
 формы изображения 
 

Автоматическое 
оцифровывание рисунков 
 
Вы можете автоматически оцифровать весь 
оригинальный рисунок, используя функцию Auto 
Stitch. Альтернативно, используя инструмент 
Magic Wand (Волшебная палочка), вы можете 
создать заполнение стежками для вышивки 
крестом по цветовым фрагментам рисунка. 
 
Оцифровывание инструментом Auto 
Stitch 
 

Используйте инструмент Auto Stitch 
(панель Design) для автоматического 
создания по рисунку проектов для 

              вышивки крестом. 
 
Вы можете автоматически оцифровать весь 
оригинальный рисунок, используя функцию Auto 
Stitch. Вы можете позже изменять вручную тип 
стежка, если вам это потребуется.  
 
Совет: Вы можете также выбрать для 
вышивания цветовые блоки в вашем рисунке, 
используя функцию Magic Wand. Подробнее см. 
в разделе Оцифровывание Волшебной 
палочкой, 
 
Как оцифровывать инструментом 
Auto Stitch 
1 Подготовьте надлежащим образом 

изображение. 
 

 Для очистки изображения используйте какую-
либо графическую программу. 

2 В режиме Picture загрузите рисунок. 
 Подробнее см. в разделе Вставка растровых 

изображений. 
 
 
 
 
 
 
 
 
 
 
 
3 В режиме Design щелкните по значку Auto 

Stitch и щелкните по изображению.  
 Откроется диалоговое окно Auto Stitch. 
 
 
     Выбор таблицы ниток Назначение максимума цветов 
Выбор метода  
отображения  
изображения 

  
 
Выбор для пропуска цвета фона 

 
 

4 Выберите, как отображать цвета 
рисунка: 

◄ Current Palette (Текущая цветовая 
палитра): Используется только текущая 
цветовая палитра. 
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◄ Specific Thread Chart (Назначенная 

таблица ниток): Используются только 
цвета выбранной таблицы ниток. 

                

 
Текущая 
цветовая 
палитра: 
Ограниченное 
количество  
цветов 
 

Назначенная 
таблица ниток: 
CSD 

Назначенная 
таблица ниток 
Isacord 40 
модных цветов 

 
5 Назначьте максимальное количество 
используемых цветов. 

◄ Unlimited (Неограниченное): Цвета ниток 
будут назначены в соответствии с 
количеством цветов в палитре, 
выбранной в первом диалоговом окне. 

◄ Restricted (Ограниченное): Введите 
количество цветов, которое вы хотите 
использовать. 

◄ Omit Background (Пропустить фон): 
Выбор для пропуска цвета фона. 

Результат будет отображен в панели 
просмотра. 

            

 
Выбрано неограниченное   Выбрано 
ограниченное  
максимальное количество  максимальное  
цветов      к
  оличество цветов 
   
6 Нажмите кнопку ОК. 
 

Рисунок оцифрован. Вам может 
потребоваться отделать некоторые 
фрагменты вручную. 

              

Выбрано 4 цвета       Выбрано неограниченное  
максимальное    
 количество цветов 

 
Примечание: Функция Auto Stitch не действует, 
если рисунок не загружен. 

 
Оцифровывание инструментом Magic 
Wand 
 

Используйте инструмент Magic Wand (панель 
Design) для создания стежков для вышивки 
крестом по цветным фрагментам рисунка. 

 
Используя инструмент Magic Wand (Волшебная 
палочка), вы можете создать заполнение стежками 
для вышивки крестом по цветовым фрагментам 
рисунка. Инструмент Magic Wand применяется как 
для заполняющих, так и для оконтуривающих 
стежков.  
 
Как оцифровывать инструментом 
Magic Wand 
1 Подготовьте надлежащим образом изображение. 
 Для очистки изображения используйте какую-

либо графическую программу. 
2 В режиме Picture загрузите рисунок. 
 Подробнее см. в разделе Вставка растровых 

изображений. 

      
 
 
3 В режиме Design щелкните по значку Magic 

Wand. 
4 Выберите тип стежка для вышивки крестом. 
5 Выберите цвет из цветовой палитры. 
6 Щелкните по цветовому блоку вашего рисунка. 
Все фрагменты этого цвета будут оцифрованы в 

выбранном цвете. 
 
 

 
Выбранный фрагмент 

 
 
 Примечание: Инструмент Magic Wand выбирает 

и оцифровывает все блоки этого цвета из вашего 
рисунка. Вы можете позже изменить тип и цвет 
стежка по своему желанию. 
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Оцифровывание букв, 
выполняемых стежками для 
вышивки крестом. 
 
 

Используйте инструмент Lettering (панель 
Design) для добавления текста к проекту.  

 
Щелчок правой кнопкой мыши открывает 
диалоговое окно Font. 
 
Как и в ПО BERNINA Embroidery Software, в 
программе Cross Stitch можно добавлять тексты 
впечатыванием непосредственно в окно проекта. 
В программе Cross Stitch для выбора шрифта, 
размера и начертания используется диалоговое 
окно Font (Шрифт). Выберите контур или 
заполнение для оцифровывания букв. 
Введенные буквы не могут быть 
отредактированы. Каждая буква 
обрабатывается, как блок стежков. 
 
 
Совет: Используйте алфавит Creative Cross для 
добавления текстовых объектов к своему 
проекту вышивки крестом.  См. Руководство 
пользователя. 
 
 
Как оцифровывать буквы, 
выполняемые стежками для 
вышивки крестом. 
1 Щелкните правой кнопкой мыши по 
значку Lettering (Текст). 
 Откроется диалоговое окно Font 
(Шрифт). 
 

 
 
 

2 Выберите из списка шрифт, начертание 
и размер. 
3 Нажмите кнопку ОК. 
4 Щелкните по начальное точке в окне 
проекта. 
5 Наберите текст и нажмите Enter. 
 
 
 
 

 

 
Буквы, выполненные   Буквы, выполненные  
заполняющими стежками  оконтуривающими  

стежками 
 
 

Совет: Для редактирования текста используйте 
инструмент Auto Select при нажатой клавише 
Ctrl во время выделения. Затем можно 
изменять тип или цвет стежков. 
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ПРИЛОЖЕНИЕ А 
 

Краткий справочник по вышивке крестом 

------------------------------------------- 
 
 
 
 
 

Этот краткий справочник детализирует все меню и 
панели инструментов программного обеспечения 
BERNINA для вышивки крестом. 

  
 
Окно BERNINA Cross Stitch Design  
 
Строка заголовка 
Строка меню 
Общая панель инструментов 
Панель режимов просмотра  
 
 
Панель изображения/образца 
(меняется в зависимости от  
Выбранного режима 
просмотра) 
 
 
 
 
 
 
 
 
 
 
 
 
Панель стежков и палитры 
цветов  
Строка состояния 
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Строка меню BERNINA  
 
Строка меню окна BERNINA Cross Stitch располагает описываемыми ниже 
выпадающими меню.  Некоторые из них доступны также через кнопки панелей 
инструментов. 
Примечание: Стандартная клавиша Alt системы Windows® используется для 
клавиатурных команд. Используйте клавишу Alt совместно с подчеркнутой в 
меню буквой. Для отмены операции нажмите дважды клавишу Esc. 
 
Меню File (Файл)  Меню View (Вид) 
New  Открыть новый пустой проект    By Color  Показать только выбранные цвета в 

проекте.  
Open  Открыть проект.   Show 1:1  Показать проект в натуральную 

величину.  
Close  Закрыть текущее окно проекта   Show All  Показать проект целиком.  
Save  Сохранить текущий проект   Zoom Box  Увеличить и уменьшить изображение в 

окне проекта и увеличить в 
оконтуренных областях до полного 
размера окна.  

Save As  Сохранить текущий проект под 
другим именем, в другом месте или 
формате  

 Redraw  Перерисовать проект.  

Design 
Properties  

Показать информацию о проекте, 
такую как размеры или количество 
стежков, и добавить комментарии о 
проекте для распечатки.  

 Grid Показать или скрыть сетку и изменить 
настройки сетки  

Recent 
File List  

Показать список недавно 
использованных файлов. Выбрать 
файл для открытия.  

 Crosses Показать стежки в виде цветных плиток 
или крестиков. 
 

Exit  Закрыть все открытые проекты и 
выйти из программы BERNINA Cross 
Stitch .  

 Picture  Показать или скрыть рисунок фона.  

Меню Edit (Редактировать) 
 Hoop  Отобразить или скрыть пяльцы /  

изменить размеры пялец 
Undo  Отменить последнюю команду.   Measure Измерить размер проекта  
Redo  Повторить выполнение отмененной 

команды.  
   

Cut  Удалить выделение с помещением в 
буфер обмена.  

 Меню Arrange (Расположение) 
Copy  Скопировать выделение в буфер 

обмена.  
 Center 

Design  
Центрировать проект в пяльцах 

Paste  Вставить содержимое буфера 
обмена в окно проекта.  

 Mirror 
Horizontal  

Перевернуть выбранные объекты по 
горизонтальной оси.  

Duplicate  Дублировать выделение с 
помещением в текущее выделение.  

 Mirror 
Vertical  

Перевернуть выбранные объекты по 
вертикальной оси.  

Delete  Удалить выделение без помещения в 
буфер обмена.  

 Меню Settings (Настройки)   
Select All  Выделить все объекты в проекте.   Thread 

Colors  
Назначить цвета ниток для 
использования в проекте.  

Deselect 
All  

Отменить выделение всех объектов 
в проекте.  

 Fabric Count Вести числа стежков на дюйм или мм 

Insert При выбранной опции Insert вы 
можете добавлять в квадрат больше 
одного стежка. В противном случае 
новый стежок заменит 
существующий стежок. 
 

 Fabric 
Display  

Выбрать ткани и цвета фона.  

Options  Выбрать настройки для отображения 
окна.  

Display 
Setup  

Калибровать экран.  

   Scanner 
Setup  

Настройка опций сканера.  

Меню Arrange (Расположение) 
Center 
Design  

Центрировать проект в пяльцах 

Mirror Перевернуть выбранные объекты по 
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Horizontal  горизонтальной оси.  
Mirror 
Vertical  

Перевернуть выбранные объекты по 
вертикальной оси.  

Меню Help (Помощь)   
Вызов 
справки  

Список разделов справки.  

Справочное 
руководство 

Открыть Руководство пользователя в 
Adobe Acrobat PDF 

 

Панели инструментов BERNINA для вышивки крестом 
 
Ниже описана панель инструментов окна ждя вышивки крестом. 
 
Режим вкладки  
В данном окне имеются две вкладки. В разных вкладках – разные панели инструментов. 
 
В программном пакете BERNINA Cross Stitch предусмотрено два режима просмотра. В разных режимах 
отображаются разные панели инструментов. 

 

Загрузка, правка и сохранение рисунков в 
качестве  фона для проекта. Вышивальные 
формы не показываются.  
 
Создание  и правка проектов. Просмотр 
вышивальных форм и рисунков. 

 
Общая панель инструментов (General)         Панель изображения (Picture) 
 
 

New  То же, что File > 
New.  

 

Select Object  Выбор изображений в окне проекта.  

Open  То же, что File > 
Open.  

 
Load Picture  Вставка изображения в окно проекта.  

 
Save  

То же, что File > 
Save.  

 
Scan Picture  

Сканирование изображения в 
BERNINA.  

Cut  То же, что File > 
Cut.  

 

 
Dim Picture  

Понизить или повысить яркость 
изображения, чтобы более четко 
видеть стежки в режиме Design Mode.  

Copy 
 
 
Paste 
 

То же, что Edit > 
Copy.  
 
То же, что Edit > 
Paste.   

Save Picture  Сохранение изображения после 
правки.  

Undo То же, что Edit > 
Undo.  

 

 
 
Crosses            То же, что View > Crosses. 

 
 

Redo То же, что Edit > 
Redo.  

 
 
Zoom Box 

 
То же, что View > Zoom Box.  

 
Grid 

То же, что View > 
Grid.  

 
Zoom out 2x 

 
То же, что View > Zoom out 2x.  
 

 
 
Hoop 

То же, что View > 
Hoop.  

 
Show All То же, что View > Show All.  
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Picture 

То же, что View > 
Picture.  Show 1 : 1 То же, что View >  

1 : 1.  



BERNINA ПО Cross Stitch – Краткий справочник 

BERNINA
®
 Программа «Вышивка крестом» 32 

 Панель инструментов правки (Design toolbar) 
 

 

Select Object  
Выбор объектов вышивки для изменения размеров, 
перемещения, перевод в зеркальное отображение или 
вращения.  

Polygon Select 
 
  

Выделение зон неправильной формы.   

Lettering  Создание текста и изменение свойств текстовых 
объектов.  

 
Mirror 
Horizontal  

То же, что Arrange > Mirror Horizontal.  

 
 
Mirror Vertical  

То же, что  Arrange > Mirror Vertical  

 
Rotate 
45°CCW /CW  

 
 
Поворот выделенных объектов шагами по 45°. Для 
поворота против часовой стрелки щелчок левой кнопкой 
мыши. Щелчок правой кнопкой – поворот по часовой 
стрелке.  

 
Magic Wand  
 
 

Оцифровка простых форм в проекте.  

Open Object  
 Рисование и оцифровка открытых форм.  
 
Closed Object  Рисование и оцифровка закрытых форм.  
 
 
Circle / Oval  

 
Рисование и оцифровка овалов или окружностей.  

 
 
Rectangle  

Рисование и оцифровка прямоугольников или 
квадратов.  

 
Auto Select 

 
Выбор одиночных цветовых блоков или не 
оцифрованного фрагмента.  
 

Pencil 
 
Рисование одинарного стежка или ряда стежков 
 

Eraser Удаление стежков  

Auto Stitch  Автоматическое создание по рисунку проектов для 
вышивки крестом. 
 

  

 
Area Fill 
 

 
Заполнение стежками закрытых форм или цветовых 
блоков. 
 

 
Rubber Stamp 

 
Клонирование стежков 
 
 

 
 
 
 
 
 




